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The File Menu
This menu provides file management commands, hard copy printer support and the 
standard Exit command.

Move Alt+F,M Move selected file(s) to a different directory and/or drive.
Copy Alt+F,C Copy selected file(s).

Delete Alt+F,D Delete selected file(s).
Rename Alt+F,N Rename a file or directory.

Print Alt+F,P Print file (also lets you setup the printer).
View Alt+F,V View selected file.
Edit Alt+F,E Edit selected file.

Properties Alt+F,T Set options for group objects; set file attributes for files.
Select Alt+F,S File selection options:    All, Some, and Invert.

Deselect Alt+F,L File deselection options:    All, Some, and Invert.
Exit Alt+F,E Exit SuperFind.



File Move Command
This command moves the selected file or files into a different directory or drive. It displays 
the Move dialog box which lets you specify where to move the files.
If other drive windows are open, you can move files by pressing Alt while dragging the files 
into the other drive window. You can also drag into any minimized drive window or any drive 
icon.
Notes: Moving a file is similar to making a copy and then deleting the original. The 

requirement that you press Alt while dragging is a safety measure. Without Alt, the 
drag operation copies the file(s). You can then delete the originals, if you want.

Related Topics:
Selecting Files
Using Drive Windows



File Copy Command
This command copies the selected file or files into a different directory or drive. It displays 
the Copy dialog box which lets you specify a destination.
If other drive windows are open, you can copy files by dragging them into another drive 
window. You can also drag into any minimized drive window or any drive icon.
When a Quick Access group window is open, you can drag files into it to make "instant" 
Quick Access group items.
To duplicate a file in the same directory, giving it a different name, you must select only one 
file before using the File Copy command.
Related Topics:

Selecting Files
Using Drive Windows



File Delete Command
This command deletes the selected file or files. The shortcut key for this operation is Del or 
Delete. The Delete dialog box appears and prompts you to confirm the operation.
If you are using Norton Desktop as your shell, and easy way to delete files is to drag them 
onto the SmartErase tool icon.
Related Topics:

Selecting Files
Using Drive Windows



File Rename Command
This command displays the Rename dialog box which lets you change the name of the 
selected file or directory.
To rename a file or directory to a different drive, use the File Move command.
Related Topics:

Selecting Files
Using Drive Windows



File Print Command
This command displays the Print dialog box which prints files to your printer, or launches an 
application which can print the file.
If you are using Norton Desktop as your shell, an easy way to print a file is to select it in a 
drive window and drag it onto a printer tool icon.
For unformatted text files and files that have extensions which Norton Desktop does not 
recognize, this command sends the text directly to the printer, with no special formatting.
For more complex documents, such as Paintbrush bitmap files and word processor 
documents, this command launches the application that is associated with a document. It 
passes the name of the file to print to the application and then sends the keystrokes 
Alt+F,P.
Related Topics:

Selecting Files
Using Drive Windows



File View Command
This command launches the Viewer application. There are several ways to use the Norton 
Viewer:
* Select one or more files in a drive window and then choose the View command.
* Use the View View Pane command to view each file as you select it in a drive window.
* Select one or more files in a drive window and drag them onto the Viewer tool icon.

If you have not selected any files, the View dialog box appears and lets you select a file.
Related Topics:

Selecting Files
Using Drive Windows



File Edit Command
This launches the default editor application. Select a file in a drive window and then choose 
the File Edit command to edit that file.
If you have not selected any files, the Edit dialog box appears and letsyou select a file.
Notes: In many cases, you may not need to use the File Edit command. If you have 

set up an association between an application and a file's extension (say for .TXT 
or .DOC files), you can launch the file directly by double-clicking it in a drive window.
Initially, the default text editor is set to the Desktop Editor. You can specify your own 
favorite editor or word processor by using the Configure Default Editor command 
from the Norton Desktop menu.

Related Topics:
Selecting Files
Using Drive Windows



File Properties Command
This command modifies file attributes for the selected file or files. Use the Properties dialog 
box which appears to specify which attributes to change.
Related Topics:

Selecting Files
Using Drive Windows



File Exit Command
This command closes all windows opened by SuperFind and exits.
If a search is in progress, you must click the Stop button (Alt+P) to enable this menu item.



The View Menu
Commands on this menu affect the display of drive windows.

File Pane Alt+V,F Show or hide the file pane.
View Pane Alt+V,V Show or hide the view pane.

Filter Alt+V,L Specify which types of files to show in the file pane.
File Details Alt+V,D Specify to display/hide file time, date, size and attribute in the file 

pane; view files in multiple-column layout.
Sort By Alt+V,S Specify how to sort entries in the file pane.
Viewer Alt+V,W Select viewer for view pane.



The Batch! Menu
This menu title acts as a command. Just click the menu title itself to display the Create Batch
dialog box.
Use this dialog box to create and launch a batch file which can perform some desired action 
on each of the found files. For example, you can create a batch file which starts your word 
processor and loads each of the files for editing.



The Options Menu
Commands in this menu control SuperFind searches and configuration. For help on any of 
the Options menu items, select it from the list:

Search Sets Alt+O,SAdd/edit file sets and location sets.
Match Upper/Lowercase Alt+O,U ON means character case must match in 

text searches.
OEM Text Alt+O,OCauses SuperFind to use the OEM character set for the 

selected font.
Animation Alt+O,AON means the SuperFind icon is animated (slower 

search).
Running Man Alt+O,NUses a running man instead of the animated SuperFind 

icon to indicate SuperFind status.
Reuse Drive Window Alt+O,RON means don't create multiple drive windows.

Exclusive Search Alt+O,E Speedy search "while-you-wait."
Minimized Search Alt+O,M Minimize into an icon and do searching in the 

background (e.g., large network search).



Options Search Sets Command
This command displays the Search Sets dialog box which lets you define or revise file sets 
and location sets.
Use this command if you think you will search for certain groups of files in certain locations 
in the future. Once defined, the file sets and location sets are available in the drop-down list 
boxes in the SuperFind main dialog box.



Options Match Upper/Lowercase Command
This command toggles text-search matching criteria.
When there is a check next to this menu option, SuperFind considers text to match only if 
the character case is the same. For instance, "dBase" won't match "DBASE".
When unchecked, search strings in the With Text text box of the SuperFind main dialog box 
such as "acme, inc." will match with "ACME, INC." and "Acme, Inc."
Related Topics:

Searching for Text
Speeding up the Search



Options OEM Text Command
This command causes SuperFind to use the OEM character set instead of the ANSI character 
set. Turn this option ON if you are searching a file created with a DOS text editor (DOS uses 
the OEM character set).



Options Animation Command
This command toggles on and off the display animation of the SuperFind icon which occurs 
during a search.
You might uncheck this menu option to make SuperFind work a little bit faster. However, if 
you are doing a minimized search in the background, leave this on so you can tell when the 
search is finished.
Related Topics:

Searching for Text
Speeding up the Search
Searching in the Background



Options Running Man Command
Check this command if you would like SuperFind to use an animated running man instead of 
the animated SuperFind icon to indicate that a search is in progress.
Uncheck this menu item and the Animation menu item to make the SuperFind search a little 
faster.
Related Topics:

Searching for Text
Speeding up the Search
Searching in the Background



Options Reuse Drive Window Command
By default, each search you begin opens a new drive window. This lets you keep the results 
of several different searches separate.
Note: All menu commands such as File Delete and Batch! affect the contents of the 

currently active drive window.
Uncheck this menu option if you want to discard the results of a previous search when you 
start a new search or if you want to reuse drive window settings such as those set in the 
View File Details and View Filter commands.



Options Exclusive Search Command
This command toggles on and off the ability to switch to another task while SuperFind runs.
By default, SuperFind searches in the background when you switch to another task. This lets 
you start a lengthy search while you get other work done.
For maximum speed, check this menu option. This suspends all other running programs and 
keeps you from switching to other tasks.
For background searching, uncheck this menu option. This lets you switch to another task as
SuperFind searches.
Related Topics:

Speeding up the Search
Searching in the Background



Options Minimized Search Command
This command selects or deselects whether SuperFind minimizes itself when it begins the 
search.
Check this menu item if you want SuperFind to minimize automatically.
Related Topics:

Searching in the Background



The Help Menu
Commands on this menu provide help on using SuperFind and provide access to the 
standard Windows help-for-help information. 

Index Alt+H,I SuperFind Help index.
Keyboard Alt+H,KQuick reference to keystrokes for SuperFind.

Commands Alt+H,CMenu commands. You can also get help on a particular menu item by 
selecting it and then pressing F1.

Procedures Alt+H,PCommon procedures and general topics.
Using Help Alt+H,UHow to use the Windows help system. You can press F1 now if you 

want to see that help file.
About... Alt+H,AProduct name, copyright, credit and version of this program.



SuperFind Keys
Use the following keys in SuperFind:
Ctrl+Click Add file/directory to an out-of-sequence selection.
Shift+Click Extend selection to this item.
Shift+Drag Extend selection (rather than drag-and-drop operation).
Alt+Drag Move file/directory (rather than copy).
Double-click Launch selected program or document file.
Delete Delete selected files.
Tab Move keyboard focus to next pane or control.
Shift+Tab Move keyboard focus backward one pane or control.
Alt+Tab Cycle through running tasks; release Alt when there.

Select file/directory below.
Select file/directory to the right.
Select file/directory above.
Select file/directory to the left.

Shift+ Extend selection up.
Shift+ Extend selection down.
Shift+ Extend selection left.
Shift+ Extend selection right.
Ctrl+/ Select all.
Ctrl+\ Deselect all except current item.
Home Select top file/directory.
End Select bottom file/directory.
PgDn Scroll down one screen; select bottom item.
PgUp Scroll up one screen; select top item.
Shift+F8 Start/stop out-of-sequence selection mode.
Spacebar Select or deselect item (in out-of-sequence selection mode).
F1 Access Help.
Alt+F4 Exit SuperFind.
Ctrl+F6 Make next window active.
Alt Start selecting a menu item or dialog control.
Alt+ Open a drop-down list box.
Alt+Spacebar Activate the Application Control-menu box.



SuperFind Main Dialog Box
Use this dialog box to define what to search for and where to search. The matching list of 
files appears in a drive window, which then lets you select some or all of the files for a 
variety of operations.
SuperFind offers many options which let you perform gigantic global searches or tightly-
focused searches. See Using SuperFind for an overview.
Find Files

Enter a filename or special wildcard file specification that identifies which files to find. 
Specify multiple wildcards by separating them with a space or comma. For example, you 
could enter *.C,*.H,*.ASM to search through files matching three different extensions. 
See Defining File Sets for other options.
You can also click the prompt button or press Alt+  to display the drop-down list box and 
select one of the pre-defined file sets. To see the definition of a particular file set name, 
use the Options Search Sets command.

Where
Specify where to search. Enter one or more drive IDs and/or directory names, separated by
spaces or commas. There are some very useful options available; see Defining Location 
Sets for more information.
You can also click the prompt button or press Alt+  to display the drop-down list box and 
select one of the pre-defined location sets.

With Text
To find files which contain a certain string of text, enter the desired text into this box. For 
example, you could search for files which contain references to "Acme, Inc." or "struct 
FooRec". See Searching for Text. for additional information.

Note: SuperFind can ignore or honor character case, depending upon the setting of the 
Options Match Upper/Lowercase menu option.

If you leave this text box blank, SuperFind locates all files which match the other criteria.
Directory

This displays the name of the current default directory. It is relevant if you choose a Where
location such as Current Directory only.

Find and Stop
Click this button to begin the search, using the criteria you have selected. Before clicking 
Find, you may want to select or deselect options in the Options menu.
As the search progresses, SuperFind displays its status and creates a drive window 
containing the files found so far. The Find button changes its title to Stop during the 
search. You can click it at any time to halt the search.

More >> and << Less
This button expands the dialog box to allow you to specify complex searching criteria. Use 
it to:
* Speed up text searches by skipping over large files and old files that are irrelevant.
* Focus a file search, for instance, to locate only files which have not been backed up.
* Help with disk housecleaning by locating large or old files.
* Help with network maintenance by looking for files owned by a particular network 

user.
Extended search criteria options include:
Date and Time

Click the prompt button or press Alt+  to access these lists. Select an option to display 
text boxes for setting the date and/or time range.



Size
Pull down the list and select an option to display text boxes to let you identify a size range.

Owner
If you are connected to a network, this drop-down list box lists the login names of all 
network users. If you choose a name, only that person's files are included in the search.

Attributes
This group of controls lets you limit the search to include or exclude files which have 
certain file attributes. These are controlled by three-state check boxes. The possible states
are:

Gray:    Ignore the attribute.
Cleared:    Find only files that do NOT have the attribute.
Checked:    Find only files that DO have the attribute.

Click the check box until its desired state is selected.
Read Only:    Find files which are tagged as undeletable and unalterable.
Archive:    Find files which have not been backed up.
Hidden:  Find files which are hidden from normal directory searches.
System:    Find files which are considered system files, such as the DOS bootstrap files.
Directory:    Find directories. You might use this to have SuperFind create a list of 
directories for manipulation using the Batch! command. This option is cleared by default
since most searches are for files and the contents of files.

Note: You can later change the attributes of found files using the File Properties 
command.



Search Sets Dialog Box
This dialog box appears when you choose the Options Search Sets command. It lets you 
add and edit SuperFind file sets and location sets. In other words, it lets you prepare for 
special searches by creating custom items for the Find Files and Where text boxes in the 
SuperFind main dialog box.
Use this dialog box if you often need to search through certain files in certain directories. For
instance, this is perfect for programmers who need to locate every use of a particular 
function or variable name from among program and header files.
First, select either File Sets or Location Sets (see below), then add, edit, or delete sets. 
Additions and changes are remembered for all future SuperFind sessions.
The Set List

This main list box shows the current file sets or location sets. If you want to change the 
name or description of an item, highlight it, then Edit....

SuperFind Sets
Select one of the option buttons:
File Sets: Select this if you want to edit, delete, or create a custom file set; for instance, if

you want to make it easy to search for files with a particular filename extension.
Location Sets: Select this if you want to edit, delete, or create a custom location set; for 

instance, if you want to make it easy to search for files that are in a particular directory 
or set of directories.

OK
Click this to confirm any changes you have made and return to the previous dialog box.

Cancel
Click this or press Esc to nullify any changes you have made and return to the previous 
dialog box.

Add...
This button displays the Add File Set dialog box or Add Location Set dialog box. It lets you 
create a custom search set which you can use in this and future SuperFind sessions.
You can have up to 16 location sets and 16 file sets. If Add... won't work, you need to 
delete one set to make room for another.

Edit...
First, highlight one of the sets in the set list box. Then click Edit... to display the Edit File 
Set dialog box or Edit Location Set dialog box (double-clicking a set has the same effect). It
lets you modify the name and definition of a file or location set.

Delete
First, highlight a set in the list box, then click Delete to delete that set.

Note: If you accidentally delete a set, you can neutralize the action by clicking Cancel.



Add File Set Dialog Box
This dialog box appears when you select the Add... button of the Search     Sets dialog box   
while the File Sets option button is selected. It lets you create custom file sets to simplify 
searches you may want to make in the future.
For instance, you can create a file set which searches only programming source code files:
*.C    *.H    *.ASM

Name
Enter a name for the custom set. It will be displayed in the Find Files list box of the main 
SuperFind dialog box. Brackets ([ ]) are added to this name automatically.

Definition
Enter one or more of the special wildcard file specifications, separated by a space or a 
comma. You can precede any wildcard with a hyphen to exclude files that match that 
wildcard. For instance,

-*.BAK
means all files except those having an extension of .BAK.
The hyphen is used to exclude files only if it is preceded by a space or a comma. If the 
hyphen is preceded by any character other than a space or a comma, it is assumed to be 
part of the filename.
Do not specify drive, path, or any other directory identification (such options are part of 
the Where location criteria which you can set from the main dialog box).
See Defining File Sets for information on the special SuperFind wildcards and related 
information.



Edit File Set Dialog Box
This dialog box appears when you click Edit... in the Search Sets dialog box while the File 
Sets option button is selected. It lets you change the name and definition of a file set to 
simplify searches you may want to make in the future.
Name

The File Set name appears in the Search Sets dialog box and in the drop-down list in the 
main dialog box. Use a descriptive title. Brackets ([ ]) are added automatically.

Definition
Modify the list of special wildcard file specifications, separated by a space or a comma. For
example, to include your correspondence files in (Documents) searches, you might add:
,*.LTR to the end of the set.
Do not specify drive, path, or any other directory identification (such options are part of 
the Where location criteria which you can set from the main dialog box or via the Add 
Location Set dialog box).
See Defining File Sets for information on the special SuperFind wildcards and related 
information.



Add Location Set Dialog Box
This dialog box appears when you click Add... in the Search Sets dialog box while the 
Location Sets option button is selected. It lets you create custom location sets to simplify 
searches you may want to make in the future. See Creating Location Sets for an overview.
For programmers, it is handy to search special path lists saved in the DOS environment, 
such as your LIB or INCLUDE environment variables. See Searching Environment Variable 
Paths for additional information.
Name

Enter a name for the custom set. It is displayed in alphabetical order in the Where box of 
the main SuperFind dialog box.

Definition
Enter one or more drives and/or paths, each separated by a space or a comma. You can 
use one or more of the special SuperFind location specifiers to identify a range of drives, 
directories on a network, a directory plus its subdirectories, even directories listed in an 
environment variable. See Creating Location Sets for additional information.
Do not specify wildcard filenames (such as file extensions) here; only drive and directory 
information.
You can also click Drive... and/or Directory... as an aid to selecting the locations to 
search. These options automatically fill in the Definition text box.

Drive...
Click this button to display the Select Drives to Search dialog box. Drives you choose here 
are automatically displayed in the Definition text box.

Directory...
Click this button to display the Select Directories to Search dialog box. Directories you 
choose here are automatically displayed in the Definition text box.



Edit Location Set Dialog Box
This dialog box appears when you click Edit... in the Search Sets dialog box while the 
Location Sets option button is selected. It lets you modify a location set to simplify 
searches you may want to make in the future.
Name

You can change this name, which appears in alphabetical order in the Where list box of the
main SuperFind dialog box. Brackets ([ ]) are added automatically.

Definition
Change the definition entirely, or add one or more drives and/or paths, each separated by 
a space or a comma. Use one or more of the special SuperFind location specifiers. See 
Creating Location Sets for additional information.
Do not specify wildcard filenames (such as file extensions) here. Such criteria appear in 
the Find Files text box, which you can assign from the main dialog box.
You can also click Drive... and/or Directory... to help specify locations to search. These 
options automatically fill in the Definition text box.

Drive...
Click this button to display the Select Drives to Search dialog box. Drives you choose here 
are automatically displayed in the Definition text box.

Directory...
Click this button to display the Select Directories to Search dialog box. The directory you 
choose here is automatically displayed in the Definition text box.



Select Drives to Search Dialog Box
This dialog box appears when you click Drive... in the Add or Edit Location Set dialog boxes.
It provides an easy way of selecting drives to be made part of a location set.
The Drive List

The scrolling list lets you select from all DOS-defined drives, including SUBST and network 
drives. Click the drives you want to search.

Note: If you select any items in Drive Types, they are highlighted in this list and displayed 
at the bottom of the dialog box. You can then deselect one or more of the selected 
drives by clicking on them.

Drive Types
You can select one or more of these check boxes to quickly pick a type of drive to be 
highlighted in the drive list. The drive letters of the chosen drives are displayed along the 
bottom of the dialog box.
All Floppy Drives:    Automatically highlights drives known to be diskette drives.
All Hard Drives:  Automatically highlights drives known to be hard disk drives. 

Note: If you have any SUBST drives, they are also highlighted and you should deselect 
them to avoid having SuperFind search them twice.

All Network Drives:  Automatically highlights all network drives to which you currently 
have access.

OK
Click this button to confirm your selections and return to the previous dialog box. There, 
you can further modify the returned value.



Select Directories to Search Dialog Box
This dialog box appears when you click Directory in the Add or Edit Location Set dialog 
boxes. It provides an easy way of selecting directories to be made part of a location set.
Drive

Enter a drive letter to display a directory tree for the selected drive, or click the prompt 
button or press Alt+  to select a drive from the list.

The Directory List
The Directory tree list box lets you select from all directories on the selected drive. Select 
a directory by clicking it.

Include Subdirectories
When checked, a plus (+) special SuperFind location specifier is appended to the directory 
name when you click OK. It means the set includes the selected directory plus all of its 
subdirectories and their subdirectories.

OK
Click this button to confirm your selections and return to the previous dialog box. There, 
you can further modify the returned value.



Create Batch Dialog Box
This dialog box appears when you choose the Batch! command. It lets you create a text file 
containing all of the filenames in the SuperFind drive window. The text file can take the form 
of a DOS batch file, in which each line contains a DOS command that performs some custom
action on each file.
See Creating a Batch File for details and examples.
Save As

Enter the name of the file you want to save to, or use the Browse... button to help select 
a drive and directory.

Browse...
Click this button to display the Standard Browse... dialog box. Use it to choose a drive, 
directory and filename.

Insert Before Filename and Append After Filename
Enter text in either or both of these boxes to specify what action to take with each 
filename. Examine the Sample line to see an example or how each line of the file will look. 
For instance:

pkzip oldstuff.zip (in the "Before" box)
/sPassWord (in the "After" box)

runs a program named PKZIP, specifies a ZIP archive, gives the name of each file to 
compress, and specifies a command parameter after each filename.
To generate a simple ASCII text file containing each filename on a line by itself, leave both 
of these fields blank.

Sample
This shows an example of how the output will look. You can select the following check 
boxes to modify the output:
Full Path:    When checked, the full drive, path and filename of each file are inserted 

between the "Before" and "After" text. When clear, only the filename and extension are 
used.

Spaces Around Filename:  When checked, a space character is added before and after 
each filename. When building a Batch Runner batch file, there are many cases where 
you want text (usually quote marks) to come right next to the filename. In that case 
uncheck this check box.

CALL Each Command:  When checked, the word CALL is inserted at the start of each 
line. Use this if the command in the "Before" text box is a batch file (otherwise control 
won't return to the FILELIST.BAT batch file).

PAUSE After Each Command:    When checked, this adds a line containing the DOS 
PAUSE command between each line in the output file. This lets you easily abort the 
batch file by pressing Ctrl+C at the "Press Any Key..." line displayed by the PAUSE 
command.

OK
This generates the batch file specified in the dialog box. You can execute the batch file by 
using the Norton Desktop or Quick Access File Run command.

Launch
This generates a temporary batch file (the text in the Save As text box is moot) and then 
runs it in a DOS command line session.



SuperFind Procedures
Using SuperFind
Searching for Text
Using Drive Windows
Defining File Sets
Defining Location Sets
Speeding Up the Search
Searching in the Background
Searching Environment Variable Paths
Creating Quick Access Objects
Creating a Batch File to Process Found Files



Using SuperFind
SuperFind is a =Fast and convenient way to find files in a tangle of drives and directories. It 
lets you:
* Search for files, using a wide range of search criteria, including searching multiple local 

and network drives.
* Search for text; e.g., locate all files that contain "Acme,Inc." or "CreateDialog."
* Search for old files, large files, unbacked-up files, etc. Great for disk housecleaning.
* Search in the background. Start a lengthy text search on several network drives and then 

continue work on something else.
The files found are placed into a drive window where you can select one or more of them 
and view, edit, print delete, copy, move or set file attributes for the selected set. You can 
also launch any file by double-clicking it. And you can drag it into a group window to create a
Quick Access group item.
SuperFind lets you create a batch file using the found filenames. You can perform one or 
more custom actions on each of the files.
To start SuperFind:
* Choose Find from the Norton Desktop File menu.

Or,
* Type SFIND.EXE in the Windows Program Manager's Run dialog box.

Or, 
* Double-click the SuperFind icon in the Norton Desktop Applications group window.

To find files:
1 Enter a filename or special file specification wildcard in the Find Files text box.

Or, display the drop-down list box and select a file set.
2 Enter a drive ID, path, or location wildcard in the Where text box.

Or, display the drop-down list box and select a location set.
3 You can click More>> to set additional criteria, such as file size, file attributes and date 

range.
4 Click Find.

To search for text:
1 Select a file set in the Find Files text box.
2 Select a location set in the Where text box.
3 Enter a piece of text you think is contained in the file in the With Text text box. For the 

best chance of finding a match, make sure that the Match Upper/Lowercase menu 
option is OFF.

4 Click Find to start searching.
5 As the search progresses, files may start to appear in the drive window. You can click the 

View Pane button to look at the file contents, even as the search continues.
6 After the search is finished (you can abort it by clicking the Stop button) you can choose 

the Viewer Find... command from the View menu to display and highlight the places in 
the file that match a search string.

To get other work done as SuperFind searches:
1 Set up your search criteria in the SuperFind main dialog box.



2 Check the Minimized Search menu option.
3 You may also want to check the Options Animation command (this lets you know when 

the search is complete just by looking at SuperFind's icon).
4 Click Find to start the search and minimize SuperFind and its drive window.



Speeding Up the Search
SuperFind is very fast in any case, but you can optimize the speed by using the following tips
and techniques:
To speed up long searches:
* Turn ON the Options Exclusive option, so SuperFind gets the entire attention of the CPU.
* Turn OFF the Options Animation option so no time is lost updating the screen.
To speed up large text searches:
* Optimize your search criteria. Search only files of interest. You can use multiple wildcards.

For instance, searching the files
*.DOC,*.LTR,*.TXT,*.MMO,*.WRI

is much faster than searching *.*
* If you know roughly how old the file is or its approximate size, set up these criteria by 

using the More>> button in the SuperFind main dialog box.
* If you know the exact case of the search string, turn ON Options Match 

Upper/Lowercase (an exact-case search is slightly faster than an any-case search).



Searching in the Background
You can start SuperFind on a lengthy search (for instance, a text search of all files on several 
large network servers) and then continue the search (for hours if necessary) in the 
background, so you can continue working on other tasks.
To search in the background:
1 Set up your search criteria in the SuperFind main dialog box.
2 Check the Options Minimized Search menu option.
3 You may also want to check the Options Animation menu option (this lets you know 

when the search is complete just by looking at SuperFind's icon).
4 Click Find to start the search and minimize SuperFind and its drive window.



Searching for Text
SuperFind helps you find files which contain a specific string of text. This is especially handy 
when you just can't remember the exact spelling of the filename, or the name of the 
directory or the drive.
To search the contents of files for text:
1 Select a file set in the Find Files text box.
2 Select a location set in the Where text box.
3 Enter a piece of text you think is contained in the file in the With Text text box. For the 

best chance of finding a match, make sure that the Options Match Upper/Lowercase 
menu option is OFF.

4 Click Find to start searching.
5 As the search progresses, files may start to appear in the drive window. You can click the 

View Pane button to look at the contents, even as the search continues.
6 After the search is finished (you can abort it by clicking the Stop button) you can use the 

View Viewer Find... command to display and highlight the places in the file that match 
a search string.



Creating a Batch File to Process Found Files
SuperFind's Batch! command provides a very handy feature. It lets you create and launch a 
DOS batch file which will do something -- anything! -- with each of the files found by 
SuperFind.
The resulting batch file contains one line for each file in the drive window. On that line is 
some leading text (usually a DOS command or program name), followed by the filename, 
followed by some optional trailing text.
To run a batch file that runs a program for each found file:
1 After performing a search, choose the Batch! command (click the menu title or press 

Alt+B).
2 Type a program name and any other needed text into the Insert Before Filename text box.

For instance:
pkzip oldstuff.zip

3 Examine the Sample text box at the bottom to make certain that the line looks right. The 
resulting batch file may look something like the following:

pkzip oldbook.zip c:\wp\book\old\chap1.Doc
pkzip oldbook.zip c:\wp\book\old\chap2.Doc
pkzip oldbook.zip c:\wp\book\old\chap3.Doc
    .    .    .
pkzip oldbook.zip c:\wp\book\old\appdx.Doc

4 Click the Launch button to create and run the temporary batch file.

To perform multiple commands on each file:
1 Use Desktop Editor or any text editor to create a DOS batch file or a Batch Runner batch 

file that accepts a single parameter, the name of a file. For example, you might create:
rem ZipDel.Bat -- zips a file to "oldfiles.zip"
rem -- and then deletes the original
pkzip oldfiles.zip %1
del %1

2 Search for the desired files.
3 Choose the Batch! command.
4 Enter the name of the multiple-command batch file into the Insert Before Filename text 

box. For example:
ZipDel

5 Check the Call Each Command check box.
Note: If you don't Call a batch file, control does not return to the original batch file.
6 Click Launch to create and run the temporary batch file.

To make a simple list of filenames:
1 Search for the desired files. 
2 Choose the Batch! command.
3 Enter the desired output filename in the Save As text box (it need not end in .BAT).
4 Leave the Insert Before Filename and Append After Filename text boxes empty.
5 Click OK to create the file.

To make a list of directory names:
1 Before starting the search, click More>> in the SuperFind main dialog box.



2 Check the Directory check box in the Attributes control group.
3 Enter *.* in the Find Files text box.
4 Select the drive(s) of interest from the Where text box.
5 Click Find, then do as described above to generate the text file.



Creating Quick Access Items
As with any drive window, you can drag files from it into a Quick Access group window, or 
directly onto the desktop (to create desktop item icons).
To find all Windows-specific applications on your system:
1 In the Find Files text box, enter: *.EXE.
2 In the Where text box, select the Local Hard Drives only location set.
3 In the With Text text box, enter: requires Microsoft Windows.
4 Click Find.

To make the Windows-specific applications into Quick Access items:
1 Choose the File New command from the Norton Desktop menu.
2 Select the Group option button.
3 Enter a group name.
4 Click OK.
5 Click the SuperFind drive window to reactivate it. Make sure that at least part of your new

group window is still visible.
6 Choose the File Select All command to highlight all the files in the drive window.
7 Click and drag the files into the new group window. This creates a bunch of group item 

icons. You can delete some, drag others to other windows, and so forth.
Note: The words This program requires Microsoft Windows are in the very first part of nearly

every Windows-specific application program. There are a very few programs which 
use different wording and those will not be found by the above procedure.



Defining File Sets
A file set is a set of one or more filenames, usually including some special wildcard 
characters. Formal file sets have a name and are saved for future uses of SuperFind. You can
also type an ad hoc file set into the Find Files text box of the SuperFind main dialog box.
To use an ad hoc file set:
* In the Find Files text box of the SuperFind dialog box, simply type one or more wildcard 

file specifications, separated by commas or spaces. For example:
.WKS looks for files ending in a single specific file extension.
.LTR,*.DOC,*.TXT looks for files ending in any of the three different file extensions.
.* -*.BAK looks for all files except those ending in .BAK.

To define a file set and save it:
1 Choose the Options Search Sets command to display the Search Sets dialog box.
2 Select the File Sets option button at the bottom of the dialog box.
3 Click Add....
4 Enter a descriptive name in the Name text box.
5 Enter one or more special wildcard file specifications, separated by spaces or commas, in 

the Definition text box.
Note: Don't enter location information here (for example, don't specify a drive ID or 

directory).
6 Click OK.



Defining Location Sets
A location set describes where to look for files. It identifies one or more drives and 
directories, including directory subtrees, and it can include some special location keywords 
to handle special searches.
Formal location sets have a name and are saved for future uses of SuperFind. You can also 
type an ad hoc location set into the Where text box of the SuperFind main dialog box.
To use an ad hoc location set:
* In the Where text box of the SuperFind dialog box, simply type one or more drive IDs and 

directories (or location keywords), separated by commas or spaces. For example:
C: looks for files on one drive, the C drive.
C:-F:, NET: looks for files on drives C:, D:, E:, F:, and all of your network drives.
D:\data\lotus+ looks for files in one directory and all of its subdirectories.

To define a file set and save it:
1 Choose the Options Search Sets command to display the Search Sets dialog box.
2 Select the Location Sets option button at the bottom of the dialog box.
3 Click Add....
4 Enter a descriptive name in the Name text box.
5 Enter one or more drive IDs, directory names, and special location keywords, separated 

by spaces or commas in the Definition text box.
6 Click OK.



Searching Environment Variable Paths
Programmers especially will appreciate this feature. SuperFind lets you specify "all the 
directories names in a certain DOS environment variable" as a search location. For example, 
you can make a search location that is "all the directories in my LIB list."
To specify environment variables, just use their names, surrounded by percentage signs (%).
For example, to search your PATH, your INCLUDE, and you LIB directories, enter:

%PATH%, %INCLUDE%, %LIB%
in the Where text box of the SuperFind Main dialog box.
You can use these along with other location specifiers, such as drive IDs, directory names, 
and special location keywords.
Incidentally, SuperFind only knows about environment variables that were in effect when 
Windows started. When you start a DOS command line, it maintains a personal copy of the 
original environment.



Using Drive Windows
Norton Desktop provides drive windows for easy access to your data. Here is an overview 
and some tips on how to use drive windows.
To open a drive window:
* Double-click its drive icon.

Or,
* Choose the Window Open Drive Window command.

To select more than one file:
* Press Ctrl while clicking each file.

Or,
* Click one file, then press Shift while clicking another, to select all files between the two.

Or,
* Choose the Select Some command to select by wildcards.

See Selecting Files for related information.
To see more files in the file pane:
* Choose the View File Details command and uncheck everything except for Icon. This 

produces a multiple column file display.
* Increase the size of the drive window using its Maximize button.

To quickly move to a directory in the tree pane:
1 Make the tree pane the keyboard focus by clicking it or pressing Tab until its borders 

darken.
2 Type the first few characters of any directory name.

Or,
Type one character and press  to find the next match.

To perform global disk housecleaning:
1 Choose the View Show Entire Drive command.
2 Choose the View Sort by Type command and look for .BAK, .OLD, and other targets for 

deletion. Ctrl-click to select them.
3 Choose the View Sort by Size command and Ctrl-click large, unneeded files.
4 Choose the View Sort by Date command and Ctrl-click obsolete files.
5 Choose the View Sort by Name command and Ctrl-click unneeded duplicate files.
6 Click Delete to delete the unwanted files.

To copy files:
1 Select the files to copy.
2 Open another drive window, if you want to copy between drives.
3 Drag and drop the selection.

Hint: You can drop files right onto a drive icon to put files in the current directory.
To delete files:
1 Select the files to delete.
2 Click Delete.

Or,
Drag the selection onto the SmartErase tool icon.



To close a drive window:
* Double-click its Control-menu box.

Or,
* Press Ctrl+F4.



File Set
A file set describes which files to find. It is a list of one or more wildcard file specification 
patterns. The list may be separated by spaces or commas and any element can be preceded
by a space or comma and a hyphen (-) to indicate "except files matching this pattern." If a 
hyphen is preceded by some character other than a space or a comma, it is assumed to be 
part of the filename. Examples:
*.* All filenames and all extensions
*.doc,*.ltr Either of two extensions
*.*, -*.bakAll files except those having an extension of .BAK
Jun*.wks JUN plus 0 to 5 characters, with an extension of .WKS
???89.wksFilenames starting with any three characters, then 89, then an extension 

of .WKS
*.? Any file that has a 1-character extension

A formal file set has a name, surrounded by brackets; e.g., [All Files]. A collection of file 
sets is available in a drop-down list box in the SuperFind main dialog box. You can create 
new file sets using the Options Search Sets command.
Note: File sets do not describe file locations, such a drive IDs or directory names. Use 

location sets to describe where to search for files.



Location Set
A location set describes where to search for files. It is a list of one or more drive IDs, 
directory names and special location identifier keywords. Examples:
*: All directories in all drives
c:-e: Drives C:, D:, and E:
hard: All hard disk drives (except network drives)
c:\wp A single directory
c:\wp+ A directory plus its subdirectories
c:\wp,d:\ltrs Two directories
%lib% All directories listed in the DOS environment variable named LIB 

A formal location set has a name, surrounded by brackets; e.g., [All Drives]. A collection of 
location sets is available in a drop-down list box in the SuperFind main dialog box. You can 
create new ones using the Options Search Sets command.



SuperFind File Wildcards
SuperFind supports these wildcard characters which can be used in file sets:
* Any filename (or any extension when used after the period)
? Any one character in this position
| One or zero characters in this position ("|" is the "pipe" character)

These characters can be used between file specifications:
 (spaces) All of these mean "also search..."
+ (plus)
; (semicolon)
, (comma)
- (hyphen) This means "except..."



SuperFind Location Wildcards
SuperFind supports these characters and keywords for use in location sets:
*: All drives
d: Disk drive D: 
d1:-d2: All disk drives from D1 to D2, inclusive
d1:,d2: Two or more drive IDs, separated by commas or spaces
floppy: All floppy diskette drives
hard: All non-network hard disk drives
net: All network drives
. (period) The current directory
..(period period) The parent of the current directory
d:\path A single directory
d:\path+ A directory plus its subdirectories
path1,path2 Two or more directories separated by spaces or commas
%lib% All directories listed in the DOS environment variable named LIB 



Expandable/Collapsible Tree

This method of displaying your directory structure lets you expand and collapse branches of 
the directory tree in the tree pane. To expand a branch, double-click a  folder. To collapse, 
double-click a 

 folder.
When using expandable/collapsible trees, you may experience short delays as Norton 
Desktop reads the disk for directory information. To switch to a faster method of tree display,
uncheck the Use Collapsible Tree menu item on the Tree menu.



Using Expandable/Collapsible Tree Displays
Norton Desktop features two methods of displaying and utilizing directory tree displays. To 
toggle between the two methods, choose Use Collapsible Tree from the Tree menu. When
this menu item has a check mark to its left, expandable/collapsible trees are enabled in all 
drive windows and Standard Browse... dialog boxes.

When using expandable/collapsible trees, you never need to refresh the tree display, but you
may have to wait for short periods as Norton Desktop reads your disk for directory 
information.
Initially, the tree is mostly collapsed, displaying only directories that are at the same level as
the current directory.
To expand a branch:
* Double-click the  icon.
* Or, select the branch and press + (plus) on the numeric keypad.
* Or, choose the Tree Expand One Level command.
To expand all branches:
* Press Ctrl+* (asterisk)
* Or, choose the Tree Expand All command.

To collapse a branch:
* Double-click the  icon.
* Or, select the branch and press - (minus) on the numeric keypad.
* Or, choose the Tree Collapse Branch command.





Copy or Move File Dialog Box
This dialog box appears when you choose the File Copy or File Move command. It lets you 
select which directory or file(s) to copy or move and where to put them.
Directory

Displays the current directory; file specifications without a path are assumed to be in this 
directory.

Copy or Move
When no files have been selected in a drive window, this text box lets you specify which 
files to copy or move. Wildcard file specifications are allowed.
When you have selected more than one file, this line just confirms how many files the 
command affects.

To
Enter the drive and directory to use as the destination. You can click the prompt box or 
press Alt+  to select from a list of recently specified destinations, or use the Select >> 
button to expand the dialog box and use the drive and directory tree list boxes.

Include Subdirectories
Check this check box only when copying or moving an entire subtree of directories. If you 
have entered a directory name or a wildcard file specification in the Copy or Move text 
box, this copies all matching files in the specified directory and all of its subdirectories into
same-named directories on the target. The directories are created on the target drive if 
they don't already exist.

Select >>
Click this button to expand the dialog box and use the drive and directory tree list boxes to
specify a destination.

Destination
Select the target drive and directory. Double-click the drive and directory to enter them 
into the To:    text box.



Delete Dialog Box
This dialog box appears when you choose the File Delete command (or press Delete). It 
lets you select which directory or file(s)to delete.
Directory

Displays the current directory; file specifications without a path are assumed to be in this 
directory.

Delete
When no files have been selected in a drive window, this text box lets you specify which 
files to delete. Wildcard file specifications are allowed.

Include Subdirectories
Check this check box only when deleting an entire subtree of directories. If you have 
entered a directory name or a wildcard file specification in the Delete text box, this 
deletes all matching files in the specified directory and all of its subdirectories.

Browse...
Click this button to display the Standard Browse... dialog box and select a file to delete. 
The file selected is entered into the Delete text box.



Rename Dialog Box
This dialog box appears when you choose the File Rename command. It lets you select 
which directory or file to rename.
Directory

Displays the current directory; a file specification without a path is assumed to be in this 
directory.

Rename
This text box lets you specify which file or directory to rename. You can click the 
Browse... button to select a file or directory.

To
Enter the new file or directory name.

Browse...
Click this button to display the Standard Browse... dialog box and select a file to rename. 
The file selected is entered into the Rename text box.



Print Dialog Box
This dialog box lets you specify the file to print and which printer to use. It appears when 
you choose the File Print command.
Directory

Displays the current default directory. If you use the Browse... button, this shows the 
directory in which you located the file.

Print
Enter the full path and filename of the file you want to print, or use the Browse... button 
to locate a file.

To
Displays the currently selected printer. Click the prompt button or press Alt+  to display 
the drop-down list box and select a different printer. Click the Setup... button to configure 
the printer.

Note: To add printers to this list or to setup printer fonts, use the Windows Control Panel 
application (run CONTROL.EXE).

Browse...
Click this to display the Standard Browse... dialog box which helps you locate the file you 
want to print. The filename you select appears in the Print text box.

Setup...
Click this to display the Windows standard Printer Setup dialog box. You can use this to 
select printer options such as switching between portrait and landscape mode.



View Dialog Box
This dialog box lets you specify a file for viewing. It appears if you choose the File View 
command when no files have been selected in the active drive window.
Directory

Displays the current default directory. If you use the Browse... button, this shows the 
directory in which your file was located.

View
Enter the full path and filename of the file you want to view. You can use wildcards to 
specify multiple files, or use the Browse... button to locate a file.

Browse...
Click this to display the Standard Browse... dialog box which helps you locate the file you 
want to view. The filename you select appears in the View text box.



Edit Dialog Box
This dialog box lets you select a file to edit. It appears when you choose the File Edit 
command.
Directory

Displays the current default directory. If you use the Browse... button, this shows the 
directory in which your file is located.

Edit
Enter the full path and filename of the file you want to edit. You can use wildcards to 
specify multiple files, or use the Browse... button to locate a file.

Browse...
Click this to display the Standard Browse... dialog box which helps you locate the file you 
want to edit. The filename you choose appears in the Edit text box.



File Properties Dialog Box
This dialog box appears when you choose the File Properties command. It lets you select a
file and change its file attributes.
When you preselect files in a drive window, the top of the dialog box displays information 
about the selections. Otherwise, you see a box to enter the name of the file you want to 
modify.
Directory

Displays the drive and directory that contains the selected files. When you use the 
Browse... button, this area displays the name of the drive and directory you selected 
using the Standard Browse dialog box.

File
You can enter a full drive, path, and filename or a wildcard file specification to designate 
the files whose attributes you want to change. You can also click the Browse... button to 
help locate a particular file.

Attributes
These three-state check boxes let you examine and modify the file attributes for the files. 
Leave the boxes gray for attributes which you want to leave unchanged. Click once to 
clear the attribute or twice to set the attribute on all the selected files.
Read Only: When checked, the files may not be deleted or modified. You may want to 

check this setting to protect rarely modified files from accidental deletion.
Archive: This is checked if the file has not been backed up since it was created or last 

modified. You may want to set this attribute if you want a group of files to be included in 
an incremental backup, even if they have not been changed since the last backup.

Hidden and System: When either of these is checked, the file does not appear in 
standard DOS directory listings. The System attribute is generally used only for PC-DOS 
support files, such as the DOS startup programs, IO.SYS and MSDOS.SYS.
You can use the View Filter command to keep files with certain attributes from being 
displayed in any drive window.

Browse...
Click this button to display the Standard File Browse dialog box. Use it to peruse your 
drives and directories and locate a particular file. The file selected appears in this dialog 
box, displayed in the Directory line and File text box.





Select Cascading Menu
These commands are available in the File menu, under the Select menu item.

All Alt+F,S,A (or Ctrl+/) Highlights (selects) all displayed files in the active file pane.
Some Alt+F,S,S (or Ctrl+S) Displays a Select Some dialog box which lets you highlight 

a subset of the displayed files--those that match a specified wildcard.
InvertAlt+F,S,I Inverts the current selection; that is, all highlighted files are deselected and

all others are selected.
This can be very handy. For example, if you want to select all files 
except .DOC files, choose Select Some to highlight all .DOC files, then 
choose Select Invert to deselect the .DOC files and highlight all other files.

Related Topics:
Selecting Files
Using Drive Windows
File Pane Display Options



Deselect Cascading Menu
These commands are available in the File menu, under the Deselect menu item.

All Alt+F,L,A (or Ctrl+/) Highlights (selects) all displayed files in the active file pane.
Some Alt+F,L,S Displays a Deselect Some dialog box which lets you deselect a subset 

of the displayed files--those that match a specified wildcard.
Invert Alt+F,L,I Inverts the current selection; that is, all highlighted files are deselected 

and all others are selected.
Related Topics:

Selecting Files
Using Drive Windows
File Pane Display Options



View Tree Pane Command
Shows or hides the tree pane portion of the active drive window.
When the tree pane is open, you can select an entire directory or subtree and drag and drop 
it onto a tool icon, another drive window, or into a different part of the same tree pane.
Note: It is possible for Norton Desktop to be unaware of recent changes to your directory 

tree. You may need to use the View Refresh command to rescan the disk and get an 
updated, accurate picture.

Related Topics:
Using Drive Windows



View File Pane Command
Shows or hides the file pane portion of the active drive window.
When the file pane is open, you can select one or more files and drag and drop onto a tool 
icon, another drive window, a directory of the tree pane of the same drive, or directly onto 
the desktop to create a desktop item icon.
Tip: To see a multiple-column display of files in this pane, choose the View File Details 

command and clear all check boxes except Icon.
Related Topics:

Using Drive Windows



View View Pane Command
Shows or hides the view pane portion of the active drive window.
When the view pane is open, the contents of the currently selected file in the file pane are 
displayed.
Note: Commands in the View Viewer cascading menu are disabled unless a view pane is 

open.
Related Topics:

Using Drive Windows



View Filter Command
This command displays a Filter dialog box which lets you select the types of files you want 
displayed (or filtered out) of the file pane of the active drive window. You can specify a filter 
using wildcard file specification or by file attribute.
When you enable a filter, the drive window title bar changes to describe the filter.
Tip: When the message "No Files Found" is displayed in a file pane, it really means no files 

match the filter criteria. You may want to reset to an All Files filter as soon as possible 
to avoid confusion.
The filtering affects directory drag and drop operations. For instance, when you drag a 
directory into the Shredder, only the unfiltered files (those that are displayed) are 
shredded.

Related Topics:
Using Drive Windows
File Pane Display Options



View File Details Command
This command displays a File Details dialog box which lets you determine which file attribute
information you want displayed in the file pane.
You can hide the directory names that are normally shown in the file pane; they are 
displayed in the tree pane, if open.
Tip: To see a multiple-column display of files in this pane, choose the View File Details 

command and clear all check boxes except Icon.
Related Topics:

Using Drive Windows
File Pane Display Options



View Font Command
This command displays the Font dialog box which lets you select the font to be used in the 
different parts of a drive window.
Tip: When viewing program source code and other text files created in DOS text mode, a 

monospaced font such as Terminal or Courier best portrays a text mode display. 
Furthermore, a small size such as 8 point or 9 point helps display more information in 
the window.

Related Topics:
Using Drive Windows
Font Dialog Box



View Sort By Cascading Menu
These commands are available in the View menu, under the Sort cascading menu. Use 
these options to specify the order in which filenames appear in the file pane.

Name Alt+V,S,N Sort by filename.
Type Alt+V,S,T Sort by file extension; puts same-type files together.
Size Alt+V,S,S Sort by file size; use to look for large files.
Date Alt+V,S,D Sort by date and time; use to look for old or new files.

Unsorted Alt+V,S,U Display as found in the directory on the disk.
Ascending Alt+V,S,A a,b,c,...z (or small...large or old...new).
Descending Alt+V,S,D z ,y,x...a (or large...small or new...old).
Related Topics:

Using Drive Windows
File Pane Display Options



View Viewer Cascading Menu
These commands are available in the View menu, under the Viewer menu item. They are 
enabled only when the view pane is open.

Find Alt+V,V,F Activate the Find dialog box to search for text in the view pane.
Find Next Alt+V,V,N Locate next occurrence of found text.

Find Previous Alt+V,V,P Locate previous occurrence of found text.
Goto Alt+V,V,G Activate the Goto dialog box to display the file at a specified row 

and column (when viewing a spreadsheet).
OEM Text Alt+S,O Display the file contents using the OEM character set instead of 

the ANSI character set (active when checked).
Change Viewer Alt+S,G Activate the Set Viewer dialog box to select a different 

viewer to display the file.
Hint: For a comprehensive search of many files, you can use Norton SuperFind (choose Find

from the File menu) to scan through files.
Related Topics:

Using Drive Windows



Select Some or Deselect Some Dialog Box
This dialog box appears when you choose the File Select Some and File Deselect Some 
commands. It lets you quickly select (or deselect) files in a file pane by using wildcards.
Tips: Files not included in the wildcard specification are still displayed, but not selected. If 

you want to see only certain types of files, choose the View Filter command.
For help with making disjoint selections, see Selecting Files.

File
Enter one or more wildcard file specifications, separated by spaces or commas. For 
instance, entering *.WK?,*.XLS selects all Lotus 1-2-3 and Excel spreadsheet files.
Or, click the prompt button (or press Alt+ ) to display a drop-down list containing 
previously used wildcard file specification sets. Select an item from the list box.

OK
Click this button (or press Enter) to save your settings and close the dialog box.



Filter Dialog Box
This dialog box appears when you choose the View Filter command. Use it to specify the 
types of files you want displayed in the file pane.
You can specify a filter using wildcard file specification and/or file attributes. Using a filter is 
a convenient way to locate and collect a group of files, such as all files ending with .BAK, 
files which are hidden or files which have not been backed up.
Tip: When the message "No Files Found" is displayed in a file pane, it really means no files 

match the filter criteria. You may want to reset to an All Files filter as soon as possible 
to avoid confusion.
The filtering affects directory drag and drop operations. For instance, when you drag a 
directory onto the Shredder, only the unfiltered files (those that are displayed) are 
shredded.

File Type
Select an option button:
All Files:    All filenames are included under this option -- there is no filtering on filename 

or extension.
Programs:  Only files having an extension of .EXE, .COM, and .BAT are displayed.
Documents:  Only files having an extension of .DOC and .TXT are displayed.
Custom:  Select this option if you want to see only those files matching wildcard file 

specifications. Enter one or more file specifications, separated by spaces or commas. For
instance, entering *.WK?,*.XLS filters out all files except for Lotus 1-2-3 and Excel 
spreadsheet files.
Or, click the prompt button or press Alt+  to display a drop-down list box containing 
previously used file specifications. Select an item from the list box.

Attributes
Choose settings for the three-state check boxes. The three selectable states are:

(grayed) Ignore the attribute.
(checked) Filter-out files that don't have the attribute.
(cleared) Filter-out files that do have the attribute.

Read Only (Can't be deleted or modified) When checked or grayed, files tagged as read 
only are included in the display.

Archive (Needs to be archived) When checked or grayed, files which have not been 
backed up are displayed.

Hidden When checked or grayed, hidden files are displayed.
System When checked or grayed, system files are displayed.

Show Directories
When checked, subdirectories are shown in the file pane along with files.
When unchecked, only files appear in the file pane.

Set Default
If you want the same filter specifications to be used each time you open a new drive 
window, select the desired filter options, then click this button. The settings you specify 
take effect for the currently active drive window and all subsequently opened drive 
windows. By default, Norton Desktop displays all files.

OK
Saves your settings and closes the dialog box.

Note:These settings are part of the Norton Desktop configuration and can be saved as the 
defaults for future sessions.



File Details Dialog Box
This dialog box appears when you select the View File Details command. Use it to specify 
the file attributes to be shown in the file pane of a drive window. You can display many files 
at once, in a three, four or five column list.
Details

Check the check boxes containing the attributes you want displayed in the file pane.
Tips: To display files in a multi-column format, clear all but the Icon check box.

To see the maximum number of files, disable the tree and view panes and maximize 
the drive window.

Icon When checked, a small icon appears to the left of each filename. The icon visually 
represents the type of file. It is one of the following:

Executable program or batch file
Text file or word processor document
Generic document (data file)
Directory

Size When checked, the file size is displayed.
Date and Time When checked, the date and/or time that the file was created or most 

recently modified is displayed.
Tip: The format used to display time and date (leading zeros, AM/PM vs. 24-hour, etc.) is

a system-wide setting you change from the Windows Control Panel (CONTROL.EXE).
Double-click the International item to display the International dialog box.

Attributes When checked, the file attribute codes are displayed. Any of the following 
codes may appear:
r Read only: The file cannot be deleted or modified.
a Archive: Needs to be archived. The file has not been backed up since it was created

or last modified.
s System: Special support file used by DOS. The file usually has the Hidden attribute.
h Hidden: Not displayed when you use the DOS DIR commands.

Directory When checked, the name of the file's directory is displayed.
Tip: Some of the file details can extend past the right edge of the file pane. To see the 

Attributes and Directory details, you may need to enlarge the file pane.
Sample

This area shows an example file entry that corresponds to the check boxes you have 
checked in the Details group box.

Set Default
If you want the same file details to be displayed each time you open a new drive window, 
check the appropriate check boxes, then click this button. The settings you specify take 
effect for the currently active drive window and all subsequently opened drive windows. By
default, Norton Desktop displays only the file's icon.

OK
Saves your settings and closes the dialog box. The settings take effect for the currently 
active drive window.



Font Dialog Box
This dialog box appears when you select the View Font command. Use it to select a font 
typeface, style and point size to use in the panes of a drive window.
Font

Select a font from the combo box.
Font Style

Select a style. By default, "Regular" is selected.
Size

Choose a font size, in points. The combo box displays the available sizes of pre-generated 
bitmap fonts. For TrueType and other scalable fonts, standard point sizes are listed, 
although the list is not exhaustive.

Panes
Check one or more check boxes. The font settings affect only the selected panes:
Tree and File:  Settings apply only to the tree pane and file pane.
View:  Settings apply only to the view pane.
Tip: To choose different settings for different panes, use this dialog twice, checking only 

one of the check boxes each time.
Sample

This area shows an example of the font in the currently-selected style and size.
Apply to All Open Drive Windows

Check this check box if you want these settings to be used in all other open drive windows.
If checked, the settings are saved as part of your desktop configuration.
If unchecked, the settings apply to just the active drive window.

OK
Saves your selections and closes the dialog box. The settings affect the active drive 
window.



File Pane Display Options
You have considerable control over the file pane display.
To view a multiple-column list of files:
1 Choose the View File Details command.
2 Clear all check boxes except Icon.
3 Click OK.

To sort the files:
1 Open the View Sort By cascading menu (Alt+V,S).
2 Select a sorting option; Name, Type (i.e., extension) Date (and time) or Size.
3 To view the files in reverse order, choose the View Sort By command again and select 

Descending (Alt+V,S,D).
To view ONLY files matching a wildcard:
1 Choose the View Filter command.
2 Select the Custom option button.
3 Enter one or more wildcard file specifications, separated by spaces or commas.
4 Click OK.
Tip: When the message "No Files Found" is displayed in a file pane, it really means no files 

match the filter criteria. You may want to set the filter to All Files to avoid confusion.
To view all files on a disk (great for disk housecleaning):
1 Choose the View Show Entire Drive command.
2 You can sort by size, in descending order, to display the largest files on top; or sort by 

type to display files with the same extensions grouped together.
To remove the directory names from the file pane:
1 Choose the View Filter command.
2 Clear the Show Directories check box.
3 This option makes sense when the tree pane is displayed.



Selecting Files
There are several convenient ways to select (highlight) files in a file pane. Only the 
highlighted files are affected by commands such as File Delete and File Copy and by drag 
and drop operations.
Selecting with the mouse:
1 Click on a filename to select that file.
2 To extend the selection, press Shift while clicking.
3 To add one file to the selection, press Ctrl while clicking (this lets you select multiple files 

which are not next to each other).
Selecting with the keyboard:
1 Choose  and 
 to move the highlight, selecting one file.

2 To extend the selection, choose Shift+  and Shift+
.

3 To select non-contiguous files, first press Shift+F8. Use  and 
 to move the selection rectangle without selecting. Press Spacebar to select a file. Press 

Shift+F8 when finished selecting.
Selecting with menu commands:
* To select all files in the view pane, choose the File Select All command.
* To select all files matching one or more wildcards, choose the File Select Some 

command.
* To select all files except a few, first select the files you don't want, then choose the File 

Select Invert command.
* To select all files with a specific file a  ttribute  , first choose the View Filter command to 

display only files with that attribute, then choose the File Select All command.



Drive Icons

Drive icons are graphical representations of each floppy, hard and network drive on your 
system. This also includes RAM, Bernoulli and CD-ROM drives. Having all drive icons on the 
desktop provides you with a quick and easy way to open a drive window and access the 
contents of the selected drive.
The Norton Desktop Configure Drive Icons command lets you choose which, if any, drive 
icons to display and where on the desktop to display them. You are not limited to displaying 
drive icons in a column on the side of your desktop--just drag them with the mouse to any 
location and their positions are saved as part of your desktop configuration.



Drive Window

Drive windows are used in Norton Desktop and the desktop tools such as UnErase and 
SuperFind to display and manipulate files and directories.
A drive window helps you to copy, move, delete and view files, organize your directories, 
launch programs and documents, and create Quick Access items.
To open a drive window, double-click a drive icon or choose the Window Open Drive 
Window command.



Button Bar

A button bar appears at the bottom of each drive window. You can customize every button 
on the button bar, if desired.
Choose the Configure Button Bar command to:
* Change the command that each button executes.
* Change the text displayed in a button.
* Disable or enable display of the button bar.



Drive Selector

Above the tree pane is a control which lets you select a different drive for display in the 
drive window.

Click the prompt button and select a drive.

Move the keyboard focus to drive selector control by pressing Tab. Type a drive letter ID or 
press Alt+  to display the drop-down list box.



File Pane

The file pane, in the upper right side of a drive window, displays file information for the 
directory selected in the tree pane. If more than one directory is selected, information for 
the last directory appears.
* You can drag files from a file pane into a directory in the tree pane, into another drive 

window, into a drive icon or onto any tool icon.
* To select multiple files, press Ctrl while clicking files.
* Speed Search: Type the first part of a filename to highlight the first match, then press  to

find other matches.
* To display multiple columns, choose the View File Details command and uncheck all
check boxes except Icon.
* Choose the View Filter command to display only the types of files desired.
* Choose the File Select Some command to highlight files matching a wildcard.



Tree Pane

The tree pane, at the left side of a drive window, displays a hierarchical representation of the
directories in the drive.
* Select a directory by clicking on it; its files are displayed in the file pane.
* Speed Search: Type the first part of a directory name to highlight the first match, then 

press  to find other matches.
* Choose the View Tree Pane command to enable or disable the tree display and leave 

more room for the file pane.
* Choose the View Refresh command to ensure that the tree display contains up-to-date 

directory information.
* Choose the Configure Drive Window command if you prefer an expandable/collapsible 

tree display.



View Pane

The view pane, at the bottom of a drive window, displays the contents of the file currently 
selected in the file pane.
* Choose the View View Pane command (or the View button) to enable or disable the 

view pane.
* Choose the View Viewer Find command to search for text.
* When viewing a spreadsheet or database file, choose the View Viewer Goto command 

to quickly find a cell.
* Choose the View Viewer Change Viewer command to view the file in a hex dump or 

alternate format.



File Attribute
Every file is associated with a set of on/off flags that describe certain traits of the file:
r Read only (can't be deleted or modified)
a Needs to be archived (hasn't been backed up)
s System (a DOS system file; usually hidden too)
h Hidden (not displayed from DOS DIR commands)

These attributes are displayed in the file pane. You can use the View Filter command to 
show only files with (or without) certain attributes. You can change attributes of file(s) via 
the File Properties command.



Wildcard
You can use wildcard characters to specify a set of files which share similar names. The 
wildcard characters are:
* any 1-to-8 character filename (or 0-to-3 character file extension)
? any single character

Examples:
*.* any filename and any extension
*.bak any filename with an extension of .BAK
*.? any file that has a 1-character extension
*. any file that has no extension
*.WK? any filename that has an extension that starts with .WK and then any other single

character
rpt??jul.* any filename starting with RPT, then any two characters, then JUL, and having 

any extension





Viewer Dialog Box
This dialog box lets you choose a file viewer from among those that are installed on your 
system.
Current or Default Viewer

Select a viewer from the list box. Use the scroll bars to display additional viewer names. 
Click OK.

Norton Viewer (or the view pane of a drive window) automatically uses one of these viewers 
each time you open a file for viewing. The viewer used is based on the file's extension.
See Viewer File Types for a summary of applications, file types, and extensions associated 
with each viewer.
See Associating a Viewer to a File Type for information on how to tell Norton Viewer which 
viewer to use for an uncommon file extension or to force the use of a viewer other than the 
default viewer assigned to a supported file type.



Find Dialog Box
Use this dialog box to locate a specific string in the Viewer window. When viewing 
spreadsheet or database files, use it to specify what part of the document you to search.
Find

Type the text you want to find into the text box.
Match Upper/Lowercase

Check this check box if you want Norton Desktop to find an exact match. When cleared, an
UPPERCASE string is considered a match with a lowercase or MixedCASe string.

Where to Search
This group box appears when the active window contains a spreadsheet or database file. 
First select one of the option buttons:
Entire Document:  When this option button is selected, the entire spreadsheet or 

database file is searched.
Partial Document, starting at:  When this option button is selected, the two text boxes 

below indicate the starting row (record) and column (field) where the search is to begin. 
The search includes the specified location, plus all columns and rows that are to the right
of and below it.

Column (or Field):    When this option button is selected, only text in the specified column
(or database field) is searched. This is ideal for searching records of a database file to 
locate, for example, a specific customer name or city. If you are viewing a spreadsheet, 
enter a value in the text box or use the spin buttons to select a value. If you are viewing 
a database file, click the prompt button and select an item from the drop-down list box.

Row (or Record) When this option button is selected, only text in the specified row (or 
database record) is searched.

OK
Click this button or press Enter to begin the search.



Goto Dialog Box
This dialog box appears when you choose the Goto command while viewing a spreadsheet 
or database file. It lets you specify the address of a cell or database record you want to view.
With a large spreadsheet or database this may be faster than using the scroll bars to move 
through the file.
Column (or Field)

Specify a spreadsheet column or a database field.
If you are viewing a database file, click the Prompt button or press Alt+  to display the 
drop-down list box. Or, type the first character of any item in the list to move to that item. 
If you are viewing a spreadsheet, enter a value in the text box or use the spin buttons to 
locate the desired value.

Row (or Record)
Specify a spreadsheet row or a database record number.



Norton Viewer File Types
The default viewer for a particular file type depends on settings in the NDW.INI file.
See Associating a Viewer with a File Type for related information.
Note: You may have viewers not in the list below, or some viewers listed here might not be 

installed on your system. In addition, the viewer filenames may be different from those
shown here. This list shows a representative sample. Actual viewer names and 
filenames are found in the [Viewer-Parser] section of the NDW.INI file.

Documents & Text (DOC.PRS)
Microsoft Word & Word for Windows .TXT .DOC .SYS .BAT
WordPerfect (5.0 & above)
Amí & Amí Pro
Any ASCII text file

Spreadsheet
Lotus 1-2-3 (L123.PRS) .WK1 .WKT .WKS
Quattro .WKQ .WQ1
Microsoft Excel (EXCEL.PRS) .XLS

Database (DBASE.PRS)
dBASE and compatibles .DBF

Graphics
Tagged Image (TIFF.PRS) .TIF
Compuserve (GIF.PRS) .GIF
Windows Bitmap (BMP.PRS) .BMP
Paintbrush (PCX.PRS) .PCX
Icons (ICO.PRS) .ICO .NIL .DLL .EXE
WordPerfect Image (WPGI.PRS) .WPG

Compressed Archives (ZIP.PRS)
PkZip; PkPak .ZIP .PAK
Sea Arc, Zoo, Lzh .ZOO .ARC .LZH

Programs (PROG.PRS) .COM .DLL .EXE
DOS Executables
Windows Executables .DLL .EXE

Hex Dump (HEX.PRS)
Any binary file

Portions of graphics viewers Copyright © 1990-92 Halcyon Software, Inc. All rights reserved.



Associating a Viewer with a File Type
When you open a file for viewing, Norton Viewer checks the file's extension and selects a 
viewer that is associated with that extension. The topic Norton Viewer File Types lists the 
standard extension-to-viewer associations.
Note: Regardless of the default viewer used for a file, it is always possible to select a 

different view parser.
You can add to the viewer association list or modify some part of it. For example, you may 
want to display .EXE files as a hex dump or you may want to add .C and .H to the extensions
associated with the Documents & Text viewer.
Viewer associations are set up in the NDW.INI file and can be modified using Desktop Editor 
or any standard text editor. To add or modify an association:
* Use Desktop Editor or Notepad to open NDW.INI from your Windows directory.
* Look for the section labeled [Viewer-FileMap]. Lines in this section are in the form:

ext= viewer [viewer]
where ext is a file extension and viewer is the name of a view parser program. Additional
viewers (if any) are used only if the first viewer cannot understand the file's format.

* Add a new association by inserting a line in this section. The names of the view parsers 
are listed in NDW.INI under the [Viewer-Parser] section.

* Save changes to the NDW.INI file and restart Norton Desktop to put the changes into 
effect.





Standard Browse Dialog Box
Whenever a Norton Desktop application prompts you to enter a filename, you can click 
Browse and use the handy dialog box which appears to find the file (and avoid typing a long
pathname).
Directory

This line displays the current default or currently-selected directory. This text changes 
automatically when you select from the Drives and Tree list boxes.

File
* Type the filename and press Enter.
* Or, select a file from the Files list box.
* Or, type a wildcard file specification and press Enter to see only files matching that 

wildcard. You can type multiple wildcards, separating them with a comma (for example, 
*.WK?,*.XLS).

* Or, select from the List Files of Type drop-down list box to display only files matching a 
listed wildcard.

When you click OK, the selected filename is appended to the text in the Directory line 
and the result is returned to the parent dialog box.

Files
This list shows the names of files in the current directory, in alphabetical order.
* You can type the first few characters of a filename to quickly scroll to that part of the list.

Press  to find other matches.
* Or, use the scroll bar to look through this list. You can double-click a filename to 
select it and automatically confirm the dialog box.
Tree
* You can type the first few characters of a directory name to quickly scroll to that part of 

the list. Press  to find other matches.
* Or, use the scrollbar to look through this list. When you click a directory, its files are 
shown in the Files list.

Note: If the Tree display is expandable/collapsible, some directories may not be 
listed. To expand or collapse a directory, double-click its folder icon. See Using the 
Expandable/Collapsible Tree Display for related information.

Drives
* You can type a drive letter.
* Or, click the prompt button (or press Alt+ ) and use the scrollbar to look through this 

list. When you select a drive, its directories will be listed in the Tree list.
Refresh

Use this button to refresh the listings in the Tree and File lists. This is needed when you 
change diskettes in a floppy-disk drive, or after you've created a directory or file from a 
DOS window or another application.

OK
Click this button, or double-click a filename, or press Enter to confirm your selection of 
drive, directory, and filename. The combined full file specification will be used as input for 
the dialog box from which this Browse dialog box originated.

Cancel
Exits the dialog box without selecting a file.



Standard Directory Browse Dialog Box
Whenever a Norton Desktop application prompts you for a directory name, you can click the 
Directory button, and use this handy dialog box to locate the directory.
Drive

Enter a drive letter. Or, click the prompt button (or use Alt+  to display the drop-down list 
box containing available drives and select a drive from the list. The Tree list box is 
refreshed and displays all of the directories on the selected drive.

Tree
* Type the first few characters of a directory name to quickly move to that part of the list 

box. Press  to find other matches.
* Or, use the scroll bar to look through this list box. When you select a directory, its 
files are shown in the Files list box.

Note: If the Tree display is expandable/collapsible, some directories may not be 
listed. To expand or collapse a directory, double-click its folder icon. See Using the 
Expandable/Collapsible Tree Display for related information.

OK
Click this button, or press Enter to confirm your selection of drive and directory. The result
is used as input for the dialog box from which this Browse dialog box originated.

Cancel
Exits the dialog box without selecting a directory.





File Extension
A file extension is the last part of a filename, consisting of a period and up to 3 characters. 
A file is fully identified by its drive ID, directory and name.    The file's name consists of a 
base portion (1 to 8 characters), a period, and the type (0 to 3 characters).
For example, in the filename AUTOEXEC.BAT, the extension is .BAT.





File-to-Program Association
You can associate files which have a certain file extension (or file type) with a particular 
application. This lets you run your data by simply using a data file name anywhere that you 
would normally specify a program name.
For example, if the file extension .LTR is associated with your word processor program, then 
you can double-click any file having that extension to start your word processor and load 
that file.
Use the File Associate command of the Norton Desktop menu to see which file types are 
associated with which programs, and to create new associations.





Three-State Check Box Control
A three-state check box has three possible states:

Gray-filled:    Ignore the attribute or condition.
Checked:    Include the file if the attribute or condition IS true.
Cleared:    Include the file only if the attribute or condition is NOT true.

Click the check box (or press Spacebar) until the check box is in the desired state.





Batch Runner Batch File
A standard ASCII text file containing statements of the Batch Runner Windows-oriented 
batch programming language. Batch files have a file extension of .WBT.
You can create batch files using Batch Builder (located on the Norton Desktop Tools menu)
or by using any standard text editor.
To execute a batch file, use its name (including the .WBT extension) in a Run command or 
any place you would normally use a program name.





Tool Icons

Tool icons are displayed opposite your drive icons by default. However, they can be moved 
to any location on the desktop.
You can drag files from a drive window onto a tool icon to use that tool on a file or group of 
files.
You can double-click a tool icon to display its window for interactive use.
To remove a tool icon from your desktop, click it once and choose Close from its Control 
menu. Or, clear its check box in the Preferences dialog box of the Norton Desktop 
Configure menu.





‘‘Drag and Drop’’
This is a very useful file-handling technique supported by Norton Desktop for Windows. It 
lets you use the mouse to perform complex operations on-screen, with instant visual 
feedback.
Just select files and directories in a drive window and drag them (move the mouse while 
holding down the left mouse button) to a different location. The mouse pointer changes to a 
drag/drop cursor which indicates when and where it is possible to drop the files. Release the 
mouse button to complete the operation.
Some things that you can do with drag-and-drop might surprise you. For a complete 
discussion, see the help topic, 'Using Drag and Drop' in Help for Norton Desktop.



Drag/Drop Cursors
Norton Desktop provides visual feedback to help you perform drag-and-drop operations on 
files and desktop items. As you start dragging, the mouse cursor changes to one of the 
following:

You are dragging a file.
You are dragging two or more files.
You are dragging a directory.

You are dragging two or more directories.
While the cursor remains one of these, it means a drop is acceptable. As you drag the item, 
the cursor may change to:

Can't drop here.

Target is an application which will be launched to process the dragged object(s).





Minimize and Maximize
When you click  the Minimize button (Alt+Spacebar,N) located near the top-right corner 
of a window, that window shrinks into an icon and appears at the bottom of your desktop.
You can double-click the icon to restore it to its previous size.
When you click  the Maximize button (Alt+Spacebar,X) located at the top-right corner of 
a window, that window instantly expands to fill the screen.
You can click  the Restore button to restore the window to its previous size.
Tip: You can also maximize or restore a window by double-clicking its title bar.


